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MEWTOCOL7-COM Ethernet Driver

Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below:

1

System Configuration
This section lists the types of External
Devices and SIO that you can connect.

&y System Configuration” (page 3)

External Device Selection
Select a model (series) of the External
Device and its connection method.

&~ "2 External Device Selection” (page 6)

Communication Settings
This section shows setting examples for
communicating between the Display and

&~ "3 Communication Settings" (page 7)

Setup Items

This section describes communication
setup items on the Display. Set the
Display’s communication settings in GP
Pro-EX or in offline mode.

Fny Setup Items" (page 15)

Operation
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|

1 System Configuration

The system configuration in the case when the External Device of Panasonic Industrial Devices SUNX and

the Display are connected is shown.

Series CPU Link I/F SIO Type Setting Example
Ethernet (UDP) 7?.1 Setting Example 1" (page
Built-In ET-LAN
AFPTCPS41E Ethernet (TCP) 93.2 Setting Example 2" (page
AFPTCPS31E )
AFP7CPS41ES :
"3.3 Setting Example 3" (page
AFP7CPS31ES Ethernet (UDP) 1) g Example 3" (pag
FP7 AFP7CCET1
Ethernet (TCP) 12.)4 Setting Example 4" (page
"3.3 Setting Example 3" (page
AFP7CPS31 Ethernet (UDP) 1)
AFP7CPS21 AFP7CCET1
AFP7CPS31S Ethernet (TCP) 12.)4 Setting Example 4" (page

B Connection Configuration

¢ 1:1 Connection

Display External Device
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¢ 1:n Connection
Display

HUB

External Device External Device External Device

NOTE | * The maximum number of connected External Device for one Display is 32 over UDP, or 16 over
TCP.

¢ n:1 Connection

(

External Device

HUB

Display Display Display

NOTE | * The maximum number of connected Displays via the built-in ET-LAN for one External Device is
16, which includes the CPU unit's serial and USB connections. The maximum number of

connected Displays via AFP7CCET]1 for one External Device is 4.
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¢ n:m Connection

Display Display Display

HUB

/)
[
/)
[
/)
|

External Device External Device External Device

* The maximum number of connected Displays via the built-in ET-LAN for one External Device is
16, which includes the CPU unit's serial and USB connections. The maximum number of
connected Displays via AFP7CCET1 for one External Device is 4.
* The maximum number of connected External Devices for one Display is 32 over UDP, or 16 over
TCP.

(@] |

GP-Pro EX Connection Manual



MEWTOCOL7-COM Ethernet Driver

2 External Device Selection

Select the External Device to be connected to the Display.

£* Welcome to GP-Pro EX |

GrP-Frio | X Number of DevicesPLCs [T =] &

h " Use System Area Cievice Information

~Device/PLC

Device/PLC 1
Manufacturer | Panasonic Industrial Devices SUNX |L
Series MEWTOCOL7-COM Ethernet E
Fort Ethernet (UDF) [~

Befer to the manual of this Device/PLC

Becent Device/PLC
4 4

Back (B) | Communication Settings | NewScreenI Cancel

Setup Items

Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the
display.

Manufacturer

Select the manufacturer of the External Device to connect. Select "Panasonic Industrial
Devices SUNX".

Series

Select the External Device model (series) and the connection method. Select
"MEWTOCOL7-COM Ethernet".

In System configuration, make sure the External Device you are connecting is supported by
"MEWTOCOL7-COM Ethernet".

&y System Configuration" (page 3)

Port

Select the Display port to be connected to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device
(memory) of the External Device. When synchronized, you can use the External Device's
ladder program to switch the display or display the window on the Display.

Cf.  GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf.  GP-Pro EX Reference Manual "System Settings [Display Unit] - [System
Area] Settings Guide"

Cf.  Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Communication Settings

This section provides examples of communication settings recommended by Pro-face for the Display and the

External Device.

3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
Manufacturer IF‘anasonic IndustrialDevices SUN, Series  |[MEWTOCOL7-COM Ethemet Port IBhemet (UDF)y
Text Data Mode [5 Chance
Communication Settings

Port No. I 1024 3:
Timeout |5 3: (sec)

Retry |2 3
‘wait To Send ID 3: (ms) Default
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 32
Add Indirect
No. Device Name Settings Device
[&] 1 JPc [tz P Address=192.168.001.005 Port No.=60001 Enable
@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click

[Add Device] to add another External Device.

#* Individual Device Settings E

PLC1

IP Address 152, 168 1 5

Port No. IEDDD‘I 33
[ Enable Monitor, Register
Default

0KO) | Cancel |

@ Notes
*  Check with a network administrator about IP address. Do not set the duplicate IP address.
» Set IP address on the External Device address in the [Individual Device Settings] dialog box.

*  You need to set IP address on the Display in the offline mode of the Display.

~]
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B External Device Settings

Use the programming software (FPWIN GR7S) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

1 Select the [Create a New Project] option and click [OK].
2 From [Select PLC Typel], select the [FP7] option and click [OK].
3 Inthe project tree, double-click [FP7 configuration].

4 From the [Selection of function] window, select the [Built-in ET-LAN] option and click [OK].

5 From the [Built-in ET-LAN] window, click [Basic communications information].

6 Set the [Home IP address (IPv4)] property to "192.168.1.5".

7 From the [Built-in ET-LAN] window, click [User connection information settings].

8 Define the External Device setup items with the following values.

Setup Item Setting description
Connection to use specification Use
Connection type UDP/IP

Open type (server/client)

Server connection(any destination)

Open type(automatic/manual)

Open automatically.

Operating mode setting MEWTOCOL-7
Home port number 60001
Unused connection disconnect time 0

Destination setting method

Specify by IP address (IPv4).

Destination IP address/name

192.168.1.1

Destination port number

1024

9 Click [OK].

@ Notes

Check with a network administrator about IP address. Do not set the duplicate IP address.

GP-Pro EX Connection Manual




MEWTOCOL7-COM Ethernet Driver

3.2 Setting Example 2
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
Manufacturer IF‘anasonic IndustrialDevices SUN, Series  |[MEWTOCOL7-COM Ethemet Port IBhemet (TCP)
Text Data Mode [5 Chance
Communication Settings

Port Ne. |1:z; 3: IV futo
Timeout |5 3: (sec)

Retry ID 3
Wiait To Send [ = (ms) Default |
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Name Settings Device
[&] 1 [PLcT [tz [P Address=192.168.001.005 Part No.=60001 Enable
@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click

[Add Device] to add another External Device.

£# Individual Device Settines E

PLC1

IP Address 152, 168 1 5

Port No. IEDDD‘I 33

™| Enable Monitor. Register
Default |
0KO) | Cancel |

@ Notes
*  Check with a network administrator about IP address. Do not set the duplicate IP address.
» Set IP address on the External Device address in the [Individual Device Settings] dialog box.

*  You need to set IP address on the Display in the offline mode of the Display.
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B External Device Settings

Use the programming software (FPWIN GR7S) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

1 Select the [Create a New Project] option and click [OK].

2 From [Select PLC Typel], select the [FP7] option and click [OK].

3 Inthe project tree, double-click [FP7 configuration].

4 From the [Selection of function] window, select the [Built-in ET-LAN] option and click [OK].
5 From the [Built-in ET-LAN] window, click [Basic communications information].

6 Set the [Home IP address (IPv4)] property to "192.168.1.5".

7 From the [Built-in ET-LAN] window, click [User connection information settings].

8 Define the External Device setup items with the following values.

Setup Item Setting description
Connection to use specification Use
Connection type TCP/IP
Open type (server/client) Server connection(any destination)
Open type(automatic/manual) Open automatically.
Operating mode setting MEWTOCOL-7
Home port number 60001
Unused connection disconnect time ™’ 10

*1  Set Unused connection disconnect time to 10 (sec) or more.

9 Click [OK].

@ Notes

*  Check with a network administrator about IP address. Do not set the duplicate IP address.
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3.3 Setting Example 3
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
Manufacturer IF‘anasonic IndustrialDevices SUN, Series  |[MEWTOCOL7-COM Ethemet Port IBhemet (UDF)y
Text Data Mode [5 Chance
Communication Settings

Port No. I 1024 3:
Timeout |5 3: (sec)

Retry |2 3
Vit To Send [ = (ms) Default |
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 32
Add Indirect
Mo. Device Name Settings Device
[&] 1 JPc [tz P Address=192.168.001.005 Port No.=60001 Enable
@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click

[Add Device] to add another External Device.

£# Individual Device Settines E

PLC1

IP Address 152, 168 1 5

Port No. IEDDD‘I 33

™| Enable Monitor. Register
Default |
0KO) | Cancel |

@ Notes
*  Check with a network administrator about IP address. Do not set the duplicate IP address.
» Set IP address on the External Device address in the [Individual Device Settings] dialog box.

*  You need to set IP address on the Display in the offline mode of the Display.
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B External Device Settings

Use the configuration software (ConfiguratorWD) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

1 Start up the configuration software.

2 From the [Option] menu, select [Select the IP of PC] to display the [Setting IP Address] window.

3 Select the [Specify the IP address of PC] option, and click [OK].

4 From the [Search] menu, select the [Search BroadCast] option.
The connected External Device will appear.

5 Click the External Device to set up its IP address, and from the [Edit] menu select the [Setting [P Address]
command.

6 Select the [Use this IP Address] option.

7 Set the IP Address to "192.168.1.5", and click [OK].

8 From the [Edit] menu, select [Communication Setting] to display the [Communication Setting] window.

9 Set the items to the following values, and click [OK].

Setup Item

Setting description

Protocol Mode

UDP

Action Mode Server Mode
Communication Mode MEWTOCOL
Source Port No. 60001
Timeout 15

10 Click [OK].

® Notes

*  Check with a network administrator about IP address. Do not set the duplicate IP address.
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3.4 Setting Example 4
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
Manufacturer IF‘anasonic IndustrialDevices SUN, Series  |[MEWTOCOL7-COM Ethemet Port IBhemet (TCP)
Text Data Mode [5 Chance
Communication Settings

Port Ne. |1:z; 3: IV futo
Timeout |5 3: (sec)

Retry ID 3
Wiait To Send [ = (ms) Default |
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Name Settings Device
[&] 1 [PLcT [tz [P Address=192.168.001.005 Part No.=60001 Enable
@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click

[Add Device] to add another External Device.

£# Individual Device Settines E

PLC1

IP Address 152, 168 1 5

Port No. IEDDD‘I 33

™| Enable Monitor. Register
Default |
0KO) | Cancel |

@ Notes
*  Check with a network administrator about IP address. Do not set the duplicate IP address.
» Set IP address on the External Device address in the [Individual Device Settings] dialog box.

*  You need to set IP address on the Display in the offline mode of the Display.
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B External Device Settings

Use the configuration software (ConfiguratorWD) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

1 Start up the configuration software.

2 From the [Option] menu, select [Select the IP of PC] to display the [Setting IP Address] window.

3 Select the [Specify the IP address of PC] option, and click [OK].

4 From the [Search] menu, select the [Search BroadCast] option.
The connected External Device will appear.

5 Click the External Device to set up its IP address, and from the [Edit] menu select the [Setting [P Address]
command.

6 Select the [Use this IP Address] option.

7 Set the IP Address to "192.168.1.5", and click [OK].

8 From the [Edit] menu, select [Communication Setting] to display the [Communication Setting] window.

9 Set the items to the following values, and click [OK].

Setup Item Setting description
Protocol Mode TCP
Action Mode Server Mode
Communication Mode MEWTOCOL
Source Port No. 60001
Timeout ! 15

*1  Set Timeout to 10 (sec) or more.

10 Click [OK].

@ Notes

*  Check with a network administrator about IP address. Do not set the duplicate IP address.
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4 Setup Items

Set up the Display's communication settings in GP-Pro EX or in the Display's offline mode.
The setting of each parameter must match that of the External Device.

&~ "3 Communication Settings" (page 7)

NOTE | © Set the Display's IP address in offline mode.

Cf.  Maintenance/Troubleshooting Guide "Ethernet Settings"

4.1 Setup ltems in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
Manufacturer IF‘anasonic IndustrialDevices SUN, Series  |[MEWTOCOL7-COM Ethemet Port IBhemet (TCP)
Text Data Mode [5 Chance
Communication Settings
Port No. [z = ¥ auo
Timeout |5 3: (sec)
Retry ID 3:
‘wait To Send ID 3 (ms) Default |
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
No. Device Name Settings Device
[&] 1 [PLcT [tz [P Address=192.168.001.005 Part No.=60001 Enable
Setup Iltems Setup Description

Enter a port number of the External Device, using 0 to 65535.
Check into [Auto], and a port number is set automatically.

Port No.

» [Auto] option is available to set only when you select "Ethernet (TCP)" in [Connecting

Method].
) Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response
Timeout .
from External Device.
Retr In case of no response from the External Device, use an integer from 0 to 255 to enter how
y many times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.
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NOTE | * Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf.

GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect

Device)"

 If communication is interrupted during TCP communication, reconnecting communication will

take some time.
The following tables show the amount of time required from interruption to reconnection. A

communication error (RHxx065) displays until connection is re-established. The communication

error does not appear if the time it takes for the Display to return to RUN mode exceeds the time it

takes to re-establish communication.
As the amount of time required to reconnect depends on the Display port settings, we recommend

using [Auto] with WinGP, and “Set value” with a display other than WinGP.

Using WinGP

Operation

Display's port is
[Set value]

Display's port is [Auto]

Enter offline mode

. *
2 minutes” !

Immediate recovery

Reset

2 minutes” !

Immediate recovery

Restart WinGP

2 minutes” !

Immediate recovery

*1  Differs depending on the Windows [Time Wait] setting. (Default: 120 seconds)

Using a display other than WinGP

Operation

Display's port is
[Set value]

Display's port is [Auto]

Enter offline mode

Immediate recovery

Immediate recovery

Reset

Immediate recovery

1 minute™!

Restart power

Immediate recovery

. *
1 minute”!

*1  Differs depending on the External Device [Unused connection disconnect time] set-

ting. (Default: 60 seconds)

GP-Pro EX Connection Manual
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I ——
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click

[Add Device] to add another External Device.

#* Individual Device Settings E

PLC1

IP Address 192, 168 1. 5

Port No. IG{H}D‘I 3:

™| Enzble Monitor Register

Default |
0KO) | Cancel |

Setup Items Setup Description

Set IP address of the External Device.

IP Address

* Check with a network administrator about IP address. Do not set the duplicate IP
address.

Port No. Use an integer from 0 to 65535 to enter the port No. (Decimal) of the External Device.

Enable Monitor

Register Displays the Monitor Register setting. This property is unavailable with this driver.

GP-Pro EX Connection Manual 17
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4.2 Setup Items in Offline Mode

NOTE | * Refer to the Maintenance/Troubleshooting guide for information on how to enter oftline mode or

about the operation.
Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

* In offline mode, the number of settings you can view on one screen varies depending on the

Display in use. Please refer to the Reference Manual for more details.

4 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch

the External Device you want to set from the list that appears.

| Cormm, Device

MEWTOCOLT-COM Ethernet [UDP] Page 1/1

Port No. o Fined O futo

| 1024 v | &

Timeout(s) Vv A
Retry Tlw | A
Wait To Sendims) i v a
: 2015/09/07
B e 11:03:07
Setup Items Setup Description

Enter a port number of the Display.
Port No. Select either "Fixed" or "Auto". Enter a port number of the Display with "0-65535", when
select "Fixed". Assign automatically without affecting the input value, when select "Auto".

Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response

Timeout from External Device.

Retr In case of no response from the External Device, use an integer from 0 to 255 to enter how
y many times the display retransmits the command.

Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.
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 If communication is interrupted during TCP communication, reconnecting communication will
take some time.
The following tables show the amount of time required from interruption to reconnection. A
communication error (RHxx065) displays until connection is re-established. The communication
error does not appear if the time it takes for the Display to return to RUN mode exceeds the time it
takes to re-establish communication.
As the amount of time required to reconnect depends on the Display port settings, we recommend
using [Auto] with WinGP, and [Fixed] with a display other than WinGP.

Using WinGP

Operation

Display's port is [Fixed]

Display's port is [Auto]

Enter offline mode

. *
2 minutes’ !

Immediate recovery

Reset

2 minutes” !

Immediate recovery

Restart WinGP

2 minutes” !

Immediate recovery

*1  Differs depending on the Windows [Time Wait] setting. (Default: 120 seconds)

Using a display other than WinGP

Operation

Display's port is [Fixed]

Display's port is [Auto]

Enter offline mode

Immediate recovery

Immediate recovery

Reset

Immediate recovery

1 minute™!

Restart power

Immediate recovery

. *
1 minute”!

*1  Differs depending on the External Device [Unused connection disconnect time] set-
ting. (Default: 60 seconds)
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@ Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External

Device you want to set from the displayed list, and touch [Device].

Setup Items Setup Description

Select the External Device to set. Device/PLC name is the title of the External Device set

Device/PLC Name with GP-Pro EX. (Initial value [PLC1])

Set IP address of the External Device.

IP Address

e Check with a network administrator about IP address. Do not set the duplicate IP
address.

Port No. Use an integer from 0 to 65535 to enter the port No. (Decimal) of the External Device.

Enable Monitor

Register Displays the Monitor Register setting. This property is unavailable with this driver.
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5 Supported Devices

The following table shows the range of supported device addresses. Please note that the actual supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

[ : This address can be specified as system data area.

Device Bit Address Word Address tfltzs Remarks
External input relay X00000 - X0511F WX0000 - WX0511 “
External output relay Y00000 - YO511F WYO0000 - WYO0511 “
Internal relay R00000 - R02047F WRO0000 - WR2047 ¥l
Link relay L00000 - L1023F WLO0000 - WL1023 *
System relay SR00000 - SR0223F WS0000 - WS0223 2
Timer(Contact) T00000 - T04095 - 12
Counter(Contact) €00000 - C01023 - 2
Pulse relay P00000 - PO255F - 2
Error alarm relay E00000 - E04095 - 12
Direct input IN0O0000 - INO062F WI0000 - WI0062 23
Direct output OT00000 - OTO062F W00000 - WO0062 i |
Data register DT000000.0 - DT999423.F || DT000000 - DT999423 *1
Link register LD00000.0 - LD16383.F LDO00000 - LD16383 ¥l
Unit Memory TUMO00000.0 - UM7FFFEF UMO00000 - UM7FFFF 3
System data - SD00000 - SD00255 2
Timer set value register - TS00000 - TS04095 *1 4
;Ierner elapsed value regis- | TE00000 - TE04095 1 %4
Counter set value register | - CS00000 - CS01023 14
E?eurnter elapsed value reg- | - CE00000 - CE01023 #] *4
Index register - 10000 - I000E s

*1  You can use these devices as a global device and local device. If used as a local device, configure a program
block number. Please enter the program block number of the program with the local device.
Example:
X000 (Global external input device, address 000)
023 X000 (Local external input device, Program block 23, address 000)

*2  Write disabled

*3  Youneed to set the slot number for these devices. You can use these devices without the program block number.
Example:
S16:IN000 (Direct input device, Slot number 16, address 000)

*4  32-bit device

*5  Hexadecimal address
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NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"

« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data

displays.

B Global Devices

Device Device Name De\?ﬁz)(())o de Address Code
External input relay X /WX 0080 Word Address
External output relay Y/ WY 0081 Word Address
Internal relay R/WR 0082 Word Address
Link relay L/WL 0084 Word Address
System relay SR /WS 0089 Word Address
Data register DT 0000 Word Address
Link register LD 0002 Word Address
System data SD 0004 Word Address
Timer set value register TS 0064 Word Address
;I'elrs;z:eilapsed value TE 0065 Word Address
Counter set value register | CS 0062 Word Address
i‘é‘gﬁr elapsed value | g 0063 Word Address
Index register I 0005 Word Address
B Unit / Local Devices
Device Device Name De\?ﬁz)(())o de Address Code
. (Program No. x 0x10000) +
External input relay X/ WX 0090 Word Address
(Program No. x 0x10000) +
External output relay Y/ WY 0091 Word Address
(Program No. x 0x10000) +
Internal relay _R/_WR 0092 Word Address
. (Program No. x 0x10000) +
Link relay L/ WL 0094 Word Address
. . (Unit No. x 0x10000) +
Direct input IN/WI 0097 Word Address
. (Unit No. x 0x10000) +
Direct output OT /WO 0098 Word Address
. (Program No. x 0x10000) +
Data register DT 0014 Word Address
. . (Program No. x 0x10000) +
Link register LD 0012 Word Address
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Device Code

Device Device Name (HEX) Address Code
. (Unit No. x 0x10000) +
Unit Memory UM 0013 Word Address
) . (Program No. x 0x10000) +
Timer set value register TS 0074 Word Address
Tlmer elapsed value TE 0075 (Program No. x 0x10000) +
register - Word Address
. (Program No. x 0x10000) +
Counter set value register | CS 0072 Word Address
Counter elapsed value CE 0073 (Program No. x 0x10000) +
register - Word Address
GP-Pro EX Connection Manual 24
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7 Error Messages

Error messages are displayed on the Display screen as follows: "No.: Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem Description

No. Error No.

Name of the External Device where error occurs. Device name is a title of the External

Device Name Device set with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Displays IP address or device address of the External Device where error occurs, or error
codes received from the External Device.

Error Occurrence Area

* IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
» Device address is diplayed such as "Address: Device address".

» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE | * Refer to your External Device manual for details on received error codes.
» Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error

messages common to the driver.

W Error Code Unique to External Device

Error Code Description
(HEX) >
41 Format error
Received command in the wrong format.
42 NOT support error
Received an unsupported command.
60 Parameter error
Specified parameter contents do not exist, or cannot be used.
61 Data error
There is an error in the contact, data area, data number, size, range, or format.
62 Registration over error
Exceeded the registration limit, or operation run without any registrations.
63 PC mode error
Invalid command executed in RUN mode.
Exclusive control error
71 Executed a command that cannot be processed simultaneously with the command already in
process.
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|

Error Code Description
(HEX) 2
80 Guarantee data abnormality error
CRC code indicates an error.
91 Expansion slave unit missing error
Specified a slot number without an expansion slave unit installed.
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